
How to Use the Align Command in AutoCAD?
(Step by step)

Description

Mastering the align command in AutoCAD is essential for achieving precise and visually appealing
drawings. Whether you’re an architect, engineer, or designer, understanding how to use this powerful
tool can greatly enhance your workflow and productivity. In this comprehensive guide, we will explore
the ins and outs of the align command in AutoCAD, providing step-by-step instructions, tips, and
advanced techniques to help you align objects with ease. From aligning dimensions and scaling
objects to aligning viewports and utilizing 3D alignment, we’ll cover everything you need to know to
harness the full potential of the align command in AutoCAD.

Key Takeaways

The align command in AutoCAD allows you to align objects based on specific reference points or
alignments, ensuring precise arrangement and spacing.
Advanced options such as scaling, rotating, and mirroring are available within the align
command, offering additional flexibility in object alignment.
Object snaps play a crucial role in accurately selecting reference points for alignment, ensuring
precise positioning of objects.
Combining the align command with other AutoCAD tools and commands can further enhance
your alignment capabilities.
Utilizing layers can help organize your drawing elements and streamline the alignment process.
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Are you looking to improve your AutoCAD skills and make your drawings more precise and visually
appealing? The align command in AutoCAD is a powerful tool that can help you achieve just that. Inthis
article, we’ll explore how to use the align command effectively to align objects in your AutoCAD
drawings.

The Align Command: An Overview

The align command in AutoCAD allows you to align objects based on specific reference points or
alignments. It helps you arrange objects in a precise manner, ensuring that they are evenly spaced and
aligned as per your requirements. Whether you’re working on architectural drawings, mechanical
designs, or any other type of CAD project, the align command can greatly simplify your workflow and
enhance your productivity.

Using the Align Command Step-by-Step

To use the align command in AutoCAD, follow these simple steps:

1. Open your AutoCAD software and open the drawing file in which you want to align objects.
2. Select the objects that you want to align. You can use various selection methods, such as

clicking and dragging a selection window or using the “Select” tool to choose individual objects.
3. Once you have selected the objects, type “ALIGN” in the command line or access the align

command from the Modify panel in the Home tab.
4. After initiating the align command, AutoCAD prompts you to specify the source point. This is the

reference point that the selected objects will align to. You can choose any point on one of the
objects or specify a coordinate manually.

5. Next, AutoCAD asks you to specify the destination point. This is the reference point that the
selected objects will align with. Similar to the source point, you can select a point on an object or
input the coordinates directly.

6. AutoCAD aligns the selected objects based on the source and destination points you specified.
The alignment can be horizontal, vertical, or rotated, depending on the reference points and the
objects’ initial positions.

Advanced Alignment Options

The align command in AutoCAD offers additional options to fine-tune your alignments and achieve
more precise results. Some of these options include:

Scale: You can scale the selected objects during the alignment process, allowing you to adjust
their size while aligning them.
Rotate: In addition to aligning objects horizontally or vertically, you can also rotate them to a
specific angle during alignment. This feature is particularly useful when working with complex
drawings that require objects to be aligned at different angles.
Mirror: The align command allows you to mirror the selected objects during alignment. This can
be handy when you need to create symmetrical arrangements or flip objects to match a particular
orientation.
Object Snapping: AutoCAD provides various object snapping options, such as endpoint,
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midpoint, and intersection snapping, which can assist you in accurately selecting the desired
source and destination points for alignment.

Tips for Using the Align Command Effectively

Here are some tips to help you make the most out of the align command in AutoCAD:

1. Plan Your Alignment: Before using the align command, it’s essential to plan the desired
alignment carefully. Consider the reference points and the type of alignment (horizontal, vertical,
or rotated) that will best suit your drawing.

2. Use Object Snaps: Object snaps are invaluable when selecting precise points for alignment.
Enable the appropriate object snaps to ensure accurate positioning of the source and destination
points.

3. Combine with Other Commands: The align command can be combined with other AutoCAD
commands to achieve complex alignments. Experiment with commands like copy, rotate, and
scale to create intricate arrangements.

4. Utilize Layers: Organizing your drawing elements into layers can help you align specific groups
of objects more efficiently. By isolating layers, you can focus on aligning related objects without
affecting the rest of the drawing.

5. Save Alignment Settings: If you frequently perform similar alignments in your drawings,
consider saving your alignment settings as a named preset. This way, you can quickly apply the
preset to align objects without having to redefine the alignment parameters each time.

6. Explore Additional Alignment Tools: While the align command is a versatile tool, AutoCAD
offers other alignment tools that can further enhance your workflow. Take the time to explore
additional commands like “Distribute,” “Array,” and “Move/Copy” to achieve more complex and
efficient alignments.

FAQ: How to Use the Align Command in AutoCAD?

1. How do you align dimensions in AutoCAD?

To align dimensions in AutoCAD, you can use the “DIMALIGN” command. Follow these steps:

1. Select the dimension objects that you want to align.
2. Type “DIMALIGN” in the command line or access the command from the Dimension panel in the

Annotate tab.
3. AutoCAD prompts you to select the base dimension. Choose the dimension that you want to

align other dimensions to.
4. Next, select the dimensions that you want to align to the base dimension.
5. AutoCAD aligns the selected dimensions based on the base dimension, ensuring consistent

alignment and spacing.

2. How do you scale align?
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Scaling alignment in AutoCAD allows you to resize objects while maintaining their alignment. Here’s
how you can scale align objects:

1. Select the objects that you want to scale align.
2. Type “SCALE” in the command line or access the Scale command from the Modify panel in the

Home tab.
3. AutoCAD prompts you to specify the base point. Choose a reference point for the scaling

operation.
4. Next, AutoCAD asks you to specify the scale factor. Enter the desired scale factor or select a

reference length to scale the objects proportionally.
5. Finally, specify the reference point for the scaled objects. This point will remain fixed during the

scaling process.
6. AutoCAD scales the selected objects while preserving their alignment based on the specified

base and reference points.

3. How do I align multiple objects in AutoCAD?

To align multiple objects in AutoCAD, you can utilize the “ALIGN” command. Here’s a step-by-step
guide:

1. Select the objects that you want to align. You can use various selection methods, such as
clicking and dragging a selection window or using the “Select” tool to choose individual objects.

2. Type “ALIGN” in the command line or access the align command from the Modify panel in the
Home tab.

3. AutoCAD prompts you to specify the source point. This is the reference point that the selected
objects will align to. You can choose any point on one of the objects or specify a coordinate
manually.

4. Next, AutoCAD asks you to specify the destination point. This is the reference point that the
selected objects will align with. Similar to the source point, you can select a point on an object or
input the coordinates directly.

5. AutoCAD aligns the selected objects based on the source and destination points you specified.

4. How do you align a viewport in AutoCAD?

Aligning a viewport in AutoCAD involves adjusting its position and scale within the layout. Here’s how
you can align a viewport:

1. Access the layout tab that contains the viewport you want to align.
2. Select the viewport by clicking inside it.
3. Type “MVIEW” in the command line or access the “Viewport” panel in the Layout tab and click on

the “Move Viewport” button.
4. AutoCAD prompts you to specify a base point. Choose a reference point on the viewport or input

the coordinates manually.
5. Next, specify the destination point where you want to align the viewport. This can be a specific

location on the layout or based on existing objects.
6. AutoCAD moves and aligns the viewport based on the specified points, adjusting its position
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within the layout.

5. How do you use 3D alignment?

In AutoCAD, 3D alignment allows you to align objects in a three-dimensional space. Here’s how you
can use 3D alignment:

1. Select the objects that you want to align in 3D. These objects can be 3D solids, surfaces, or other
entities.

2. Type “3DALIGN” in the command line or access the 3DALIGN command from the Modify panel in
the Home tab.

3. AutoCAD prompts you to specify the source point. This is the reference point that the selected
objects will align to.

4. Next, specify the destination point. This is the reference point that the selected objects will align
with.

5. You may also be prompted to specify a third point to establish the rotation axis for the alignment.
6. AutoCAD performs the 3D alignment, adjusting the positions and orientations of the selected

objects based on the specified points and rotation axis.

6. How do you align a model space to a viewport?

Aligning model space to a viewport involves adjusting the view and position of the objects in model
space to match the desired view within a specific viewport. Here’s how you can align model space to a
viewport:

1. Access the layout tab that contains the viewport you want to align.
2. Double-click inside the viewport to enter model space.
3. Use the zoom and pan tools to adjust the view and position of objects in model space until it

matches the desired view within the viewport.
4. Exit model space by double-clicking outside the viewport or by using the “MSLTSCALE”

command to toggle the model space and paper space linetype scaling.
5. The viewport will now display the aligned view of the objects in model space.

7. How do I align two images in AutoCAD?

AutoCAD does not provide direct image alignment functionality. However, you can use other methods
to align images within your AutoCAD drawings. Here’s one possible approach:

1. Insert the images into your AutoCAD drawing using the “INSERT” command or by dragging and
dropping them into the drawing area.

2. Select one of the images that you want to align.
3. Use the “MOVE” command or the grip editing tools to position the image in the desired location.
4. Select the second image that you want to align.
5. Use the same positioning techniques to move and align the second image relative to the first one.

By manually adjusting the position of the images using the move command or grip editing, you can
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align them visually within your AutoCAD drawing. Remember to consider snap settings and object
snaps to ensure accurate alignment.

8. How do I align in AutoCAD 2020?

AutoCAD 2020, like previous versions, provides the “ALIGN” command to align objects. The steps to
use the align command in AutoCAD 2020 are the same as described earlier in this article. You can
follow these steps:

1. Select the objects that you want to align.
2. Type “ALIGN” in the command line or access the align command from the Modify panel in the

Home tab.
3. Specify the source point by selecting a point on one of the objects or entering the coordinates

manually.
4. Specify the destination point by selecting a point on another object or inputting the coordinates

directly.
5. AutoCAD will align the selected objects based on the specified source and destination points.

AutoCAD 2020 offers the same powerful align command, allowing you to precisely arrange and align
objects in your drawings to meet your design requirements.

9. How do I center an object in CAD?

To center an object in AutoCAD, you can use various methods depending on the type of object and the
desired centering technique. Here are a couple of common approaches:

Centering Using Object Snaps:

1. Select the object that you want to center.
2. Activate the “OSNAP” function by clicking the Object Snap button in the status bar or typing

“OSNAP” in the command line.
3. Enable the “Center” object snap by clicking on the Center option in the Object Snap menu or

typing “CEN” in the command line.
4. Move your cursor near the object’s boundary until the center snap marker appears.
5. Click to snap the object’s center to the desired location.

Centering Using Align Command:

1. Select the object that you want to center.
2. Type “ALIGN” in the command line or access the align command from the Modify panel in the

Home tab.
3. Specify a reference point within the object as the source point.
4. Choose the destination point as the desired center location.
5. AutoCAD will align the object, centering it based on the specified points.
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By utilizing object snaps or the align command, you can easily center objects within your AutoCAD
drawings, ensuring balanced and visually pleasing designs.

10. What is align system?

In AutoCAD, the align system refers to a set of commands and tools that allow you to align and
arrange objects precisely. The align system includes commands such as “ALIGN,” “DIMALIGN,” and
“MVIEW” for aligning objects, dimensions, and viewports, respectively. These commands help you
achieve consistent and accurate positioning of elements within your drawings.

By using the align system in AutoCAD, you can easily adjust the placement, spacing, and orientation of
objects, ensuring a well-organized and visually appealing design. The align system offers flexibility and
control, empowering you to create professional and precise drawings.

11. What is an example of alignment?

An example of alignment in AutoCAD is aligning a set of text objects to create a uniform and visually
pleasing layout. For instance, suppose you have a series of text labels representing different elements
in a floor plan. By using the align command, you can align all the text labels vertically or horizontally,
ensuring that they are uniformly positioned and aligned with each other. This creates a neat and
organized presentation of information within your drawing.

Alignment can also be applied to other objects, such as lines, blocks, or dimensions, to achieve
consistency, symmetry, or specific positioning requirements. The align command in AutoCAD provides
the flexibility to align objects based on various reference points or alignments, enabling you to create
structured and professional designs.

12. Do you align with or align to?

In the context of AutoCAD, both “align with” and “align to” are commonly used phrases. The choice
between them depends on the specific alignment operation and the reference points involved.

“Align with” is typically used when aligning objects based on their common reference points. For
example, you align one object with another object by positioning them so that their reference
points coincide or align.
“Align to” is often used when aligning objects to a specific reference point or coordinate. For
instance, you align an object to a particular location by specifying the destination point or 
coordinate to which the object should align.

In essence, both phrases convey the concept of adjusting the position or orientation of objects to
achieve alignment. The choice between “align with” and “align to” depends on the context and the
specific reference points or destinations involved in the alignment operation.

13. What is align dimensioning?

Align dimensioning in AutoCAD refers to the process of aligning and arranging dimension objects in a
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drawing to enhance clarity and readability. When dimensions are aligned, they are positioned in a
consistent manner, ensuring a neat and organized presentation of measurements.

By aligning dimensions, you can achieve a uniform spacing between them, making it easier for readers
to interpret the drawing. Aligning dimensions also helps in avoiding clutter and overlapping, improving
the overall aesthetics of the design.

AutoCAD provides the “DIMALIGN” command specifically for aligning dimensions. With this command,
you can select multiple dimensions and align them based on a common reference dimension or a
specific alignment point. By utilizing align dimensioning techniques, you can create professional and
well-structured technical drawings.

14. What is aligned system of dimensioning?

The aligned system of dimensioning is a method used in technical drawings to represent the size and
location of objects with precision. In this system, dimensions are aligned with the object or feature
being measured, providing clear and concise information about its measurements.

In an aligned system of dimensioning, dimensions are placed in alignment with the extension lines, and
they are positioned in a way that they do not intersect or overlap. This method ensures that dimensions
can be easily read and understood without confusion.

The aligned system of dimensioning is widely used in various industries, such as engineering,
architecture, and manufacturing. It follows standardized practices and conventions to maintain
consistency and uniformity in dimensioning, allowing accurate interpretation of drawings by
professionals and stakeholders.

15. How do I align text in dimension?

To align text within a dimension in AutoCAD, you can use the dimension style settings. Here’s how you
can align text in a dimension:

1. Type “DIMSTYLE” in the command line to open the Dimension Style Manager.
2. In the Dimension Style Manager, select the dimension style you want to modify or create a new

one.
3. In the Text tab of the Dimension Style Manager, locate the Text Alignment or Text Placement

section.
4. Choose the desired alignment option, such as Horizontal, Centered, or Aligned with Dimension

Line.
5. Apply the changes and close the Dimension Style Manager.

By adjusting the text alignment settings within the dimension style, you can control how the dimension
text is positioned in relation to the dimension lines and arrows. This ensures that the dimension text is
legible and properly aligned, enhancing the clarity and readability of your dimensioned drawings.
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Conclusion

Mastering the align command in AutoCAD is a game-changer for professionals working with technical
drawings and designs. By understanding the step-by-step process and exploring advanced techniques,
you can achieve impeccable alignment and enhance the visual precision of your drawings. Whether
you’re aligning objects, dimensions, or viewports, the align command offers a powerful set of tools to
streamline your workflow and improve productivity.

Remember to plan your alignments, utilize object snaps, and explore additional commands to
maximize the potential of the align command. Regular practice and experimentation will help you refine
your skills and develop a keen eye for precise alignments. With the knowledge gained from this guide,
you’re well-equipped to take your AutoCAD proficiency to new heights and create impressive, well-
aligned drawings that leave a lasting impact.
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